
 
 

DesKAM  2000 is a Windows 95/98/NT based CAM program that inputs a  
2-1/2D DXF or 3D STL file and creates a post processed output file. 

 
DesKAM is one of the easiest CAM programs to learn and use ! It can be used for milling, routing, 
drilling or anywhere requiring 2 1/2 D toolpath creation.  It performs spiral pockets, contouring, drilling, 
and prototyping functions. 

 Automatically detects islands and nested islands . 

 Multiple Depths - Islands on top of islands inside boundaries...etc.  

 Wall Profiles - Any region can have any wall profile. 

 Automatically chains adjoining entities into regions to give an immediate visual representation of 
whether any regions are open or closed. 

 Machining order if automatically determined, with manual override. 

 Integrated 3D Editor with real time zoom, pan, and rotate. 

 Syntax highlighted editor. 

 User defined configurations. 

 Programmable Post Processor. 

 Automatically vectorizes DXF Text. 

 Easy routing of PC Boards. 

 Prototyping of STL solids. 

 
This is an actual screen capture showing the finished tool paths and the G-code ready to be loaded 

into DeskNC. With this program you can process 2D DXF files produced by your CAD software using 
various CAM functions such as Spiral Pocketing, Contouring, and PC Board Routing. 

 



 
Here is a screen capture of a 3D teapot imported from an STL file. The toolpaths are seen around the 

STL geometry. You now have the ability to create parts of very high complexity... all from your 
computer! 

 
 

 
This plastic mold has two degree sides and was created from DesKAM 2000 

 



 
LCD display printed circuit board 

Created by DesKAM - Routed by DeskNCrt in Closed Loop Mode 
 

 
Impeller for a Model Engine Water Brake 

Created with DesKAM - Machined with DeskNC 
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1. Glossary 

 
DXF 
Common CAD File Format. Most CAD Programs can output this format. 
DesKAM only reads DXF Files (AutoCAD 10 to 14 format). 

G-Code commands 
 
G21 units = mm for coordinates and mm/min for feed rates 
G90 Absolute coordinates 
 
G00 Rapid motion 
G01 Motion at the current feedrate 
G02 Circular interpolation (Clockwise) in XY plane 
G03 Circular interpolation (CounterClockwide) in XY plane 
G04 Pause during a defined delay 
G81 Drill cycle 
 
X X axis position at the end of the move 
Y Y axis position at the end of the move 
Z Z axis position at the end of the move 
I Arc center offset X (Signed) 
J Arc center offset Y (Signed) 
 
M00 Pause program 
M02 End of program, stops spindle and motors 
M03 Start spindle or laser 
M04 Start spindle or laser with rpm or power proportional to feed rate during axis acceleration 
M05 Stop spindle or laser 
M06 Tool change 
M07 Coolant on (Mist) 
M08 Coolant on (Flood) 
M09 Coolant Off 
 
T Tool number 
F Feedrate (mm/min) 
S Spindle speed (0  to max rpm) or laser power (0 to 100) 
N Line Number 
P delay of pause in millisecond 

GRBL 
Implementation of G-CODE on DIY (Arduino, etc.) CNC machines 

Island 
A closed selected Region inside a selected Boundary. 

Nested 
DesKAM can determine if a region is within a boundary (an Island). If a region is then found inside this 
island it is defined as a nested boundary. If there is an island inside this nested boundary, it is an 
island to the nested boundary and not the outer boundary. 

Region 
An unselected string of connected entities. May be open or Closed. 

Boundary 
A closed selected Region that defines an outer boundary to a selection. It may stand alone or be 
inside an Island. 

Contour 
An Open set of connected entities. 



2. File 

2.1 Open DXF 

The Open DXF Command is used to load a DXF file. Most CAD Programs allow you to export your 
work in the DXF file format. All part geometry is automatically converted to open and closed regions 
while loading and machining order is determined while loading. 
 
To interrupt this command 
Press Esc. 
 
Tip 
You can immediately determine if a region is closed or open by its color. If a region appears open and 
you think it should be closed you can either : 
1. Press the Show Directions button with the Mark First Entity Only option selected under options. 
2. Press the Information button. 
 
Either of these will reveal the first entity in the region allowing you to decipher where the region is 
broken. 

 

2.2 Open NC File 

 
Viewing 
When viewing toolpaths, the Zoom All, Zoom In, Zoom Out, and Zoom Window functions are available 
(See Zoom Comands). The display can be cleared by the Clear button. The toolpaths can be 
displayed in 3D by selecting the 3D option in the View menu. To rotate the toolpaths in real time, hold 
the left mouse button down and drag the toolpaths. To zoom in and out, hold the right mouse button 
and the Cntrl key down and move the mouse forward or backward. To Pan the toolpaths, hold the shift 
key and left mouse button down and drag the toolpaths. 
 
Available command buttons : 
 
All Button 
Starts at the beginning and displays the entire file. 
 
Next 
Displays the next move. The line is highlighted in the edit box. 
 
Next10 
Displays the next 10 moves. The line is highlighted in the edit box. 
 
To Rapid 
Displays all moves up to and including the first G0 rapid move. Pressing this button again will display 
to the next G0 move. The line is highlighted in the edit box. 
 
To Tool 
Displays all moves up to and including the first Txx tool change code. Pressing this button again will 
display to the next Txx code. The line is highlighted in the edit box. 
 
To Cursor 
Displays all moves up to and including the line the cursor is currently on. The line is highlighted in the 
edit box. 
 
From Cursor 
Displays all moves from the line the cursor is currently on to the end of the file. The line is highlighted 
in the edit box. 
 
Search 
Selecting this button brings up a search dialog where you can search for and replace text. 
 
ReLoad 
After editing a file, you must reload the file for the edits to be seen on scree. 



Save 
Press this button to save the file after editing. 
 
Renumber 
Selecting this button brings up a ReNumber window. Line numbering follows the syntax of the 'Line 
Numbering Token' that is set in the current Post Processor. ReNumbering can only take place at the 
beginning of the current line. Enter the Start value and Increment. An option is available to add a 
space after the Line Number foe easier reading. 
 
Additional Right Click Options 
By right clicking in the edit box two more options are available. 
 
Font 
Select this option to change the Font in the Edit Box. 
 
Show Syntax 
Select this option to highlight the Machine Commands in the color and style set under Options - editor. 
 
 
 

2.3 3D editor 

 
 
 
2.4 Add Text 
 
Opens a Dialog window for exploding True Type Font vectors. 
 
Definitions and Guidelines 
 
By Point/Enter Below 
Select between entering the Origin directly or placing the origin by clicking in the workspace. When 
adding text around an Arc, this will b the center point. 
 
Linear/Arc 
Select between aligning the text linearly along the x axis or around an Arc. 
 
Left/Cent/Right 
Text can be justified to the left, center, or to the right of the origin. When adding text around an Arc, 
text can be justified to the left, center, or to the right of the Start Angle. 
 
Center X/Y of Selected 
Text can be justified to the center of any selected regions. If there aren't any regions selected, this 
feature will be unavailable. 
 
Angle/Radius 
Used for aligning text around a circle. Angle is the Start Angle of the text. 0 degrees is at the top and 
continues Clockwise. Radius is the distance from the origin to the text. 
 
Origin X/Y 
Origin used to align the text. When adding text around a circle, this will be the center point. 
 
Font 
True Type Font used to add the text. Double clicking this box will bring up a font dialog window which 
allows the selection of any True Type Font. 
 
Height 
Size of the added text. This is the maximum height of each character. 
 
Text 
Actual text to add. 

 



 

2.5 Save Toolpaths 

If the toolpaths were not saved during a toolpath command, you may save them at any time by 
selecting this command. If the toolpaths are not saved you will be prompted to do so when you exit 
DesKAM. 
 

 

2.6 Save Toolpaths to DXF File 

This command allows saving of the Toolpaths in the DXF file format. 

 

2.7 Close 
 
This command closes either the loaded DXF file or NC file and releases system resources. 

 

2.8 Exit 
 
This command ends the current session of DesKAM 2000. You will be prompted for confirmation if the 
toolpaths or DXF file have not been saved. 

 
 

3 Edit 

 
3.1 Delete Selected Regions 

This command is used to clean up a DXF File that contains a large number of Regions that you are 

not interested in. You may never need to use this command. It is available because it may make the 

geometry more readable and slightly speed up certain Pocket or Contour toolpath calculations. This 

command permanately alters DesKAM geometry. It can not be undone. The only way to undo this 

command is to reload the DXF File. 

 

Example 

If you want to Pocket a small portion of a file that contains numerous open Regions. It May speed up 

the toolpath calculations slightly and make the View easier to see if you Delete the Open Regions. 

 

3.2 Information 

This command allows you to view the ID of each region. It has a slightly different definition for each 
view. 
 
When the View is set to All and there is nothing selected 
When the view is set to all ( View All in the View Menu) and no regions are selected, a label will be 
displayed at the beginning of the first entity in each region. The number in this box is the region 
number. This command in this view can be useful in determining where a Region starts. It also defines 
the Machining Order when toolpaths are created. 
 
When the View is set to All or Selected and there is a selection 
A label will be displayed at the beginning of the first entity in each region. The first number in the box 
will be the region number DesKAM associates with each region. The (Optional) second number will be 
displayed if this region is an Island. The second number will be the number of the boundary that this 
region is an Island to. This command is useful after your selections are made to verify that indeed an 
Island is an Island to its boundary. Sometimes an Island can become an Island to a more distant 
boundary if you use many different selection commands (Select All, Open, Close, Window, Region, 
and Single) for one file. A third number may be present in parenthesis. This is the Wall Profile number 



and the DeltaX associated with this wall. 
 
When the View is set to Toolpath 
A box is displayed at the beginning of the first entity of each Toolpath region. This number 
corresponds to the order at which the toolpaths will be processed. Useful to see the order of the 
toolpath segments. 
 
Tip 
- When selecting regions, it is sometimes better to Select All regions (or a larger area than required) 
and then Deselect what you don't need. 
- If a Region is Open and you think it should be closed, using this command will mark the point where 
the Region is separated. 

 

3.3 Reverse Dir of Region 

When a DXF File is loaded, open and closed Regions are automatically created and their orientation 

set to either clockwise or counter clockwise (Depending on what option is set under Options). If 

needed, use this command to reverse a Regions direction. All closed regions should be orientated in 

the same direction in order for the Toolpath commands to work properly. This can be verified by 

the Show Directions command. 

 

3.4 Change First Entity 

This command changes the first entity in closed Region. It can be useful to set the starting point of a 

toolpath loop. 

 

Operation 

Start this command by pressing the Change First Entity button or Selecting Change First Entity from 

the Edit Menu. Then use the left mouse button to click on the entity you wish to be the starting 

segment of a closed Region. It will be marked with an arrow at its midpoint. 

 

To Cancel operation 

Press Esc. 

 

 

3.5 Set Machining Order 

 Machining Order 

With this function the order the Regions are machined can be controlled. DesKAM automatically 

determines an efficient order of machining when the DXF file is loaded. The machining order can be 

determined from the use of the Show Information function. When Set Machining Order is invoked, a 

Machining Order window pops up. Enter the first region that you want to change and press OK. Simply 

click on each Region in the order you want them machined. Example - If the first four Regions are in 

the correct machining order then enter 5 and press OK. You then proceed to select the next ( in this 

case fifth) Region to be machined. The machining order of Islands and nested Boundaries are 

automatically calculated and can not be changed. 

 

3.6 Explode/Join Selected 

Explode selected 

This function will reduce a region to its individual entities. It will create a seperate region for each entity 

which can then be joined together to form a new region. It is useful when entities intersect or coincide. 

To use this function, first select the regions you want to explode, and then press Explode Selected. 

 

Join selected 

This function will join together open regions and form new regions. To use this function, select all 

entities you want joined into new regions. They do not have to be selected in any order, nor do they all 

have to be connected to each other. DesKAM will join the ones that are connected and form a new 



region. It will not force an entity to be joined with another if they are not connected, therefore multiple 

regions may be created. If a new region is closed, it is automatically identified as closed. 

 

Tip 

If your DXF geometry has intersections, you may need the explode/join functions to create a region as 

it was intended to be. 

 

 

3.7 Combine Selected 

Combines two or more intersecting regions into 1 region. Used mainly for routing PC Boards. 

 

This feature is used mainly for combining 'traces' and 'pads' found in PC Boards. It can be used to 

reduce the number of Islands and speed up toolpath calculations when routing PC Boards. Select the 

regions and then select this command. The Status Bar will display the number of new regions and the 

number of old regions. 

 

 

4 Setup 

 

4.1 Options 

 

Here you can change the Options in DesKAM and set viewing preferences. 
 
 
Tolerances 
 
Min Arc Length 
Enter the minimum length of an Arc segment. Arcs less than this length will be converted to line 
segments. 
 
Min Arc Radius 
Enter the minimum radius of an Arc segment. Arcs less with a radius less than this value will be 
converted to line segments. 
 
Tangential Deviation 
Enter the minimum deviance that adjoining linear segments can have. Linear segments that are less 
than this value are joined into one linear segment. This value can reduce the size of the Machine 
Code file. 
 

 
Editor 
 
Color 
Enter the color of the Command, Address, or Comment that is displayed in the Edit Box when Show 
Syntax is enabled. Show Syntax allows easier reading of the Machine Code file by 'Highlighting' key 
words based on the currently loaded Post Processor. 
 
Style 
Enter the style of the Command, Address, or Comment that is displayed in the Edit Box when Show 
Syntax is enabled. Show Syntax allows easier reading of the Machine Code file by 'Highlighting' key 
words based on the currently loaded Post Processor. 
 



Misc 
 
Default Direction of Closed Regions 
The orientation (Clockwise or counterclockwise) that all closed regions will be set to when a DXF File 
is loaded. Toolpaths will be calculated from this direction. If you change this setting, you should reload 
your DXF file for the changes to take place. 
 
Mark Direction of 
Set to Mark First Entity Only if you want just the first entity in a region to have an arrow displayed at its 
midpoint. Set to Mark All Entities if you want all the entities to have an arrow displayed at its midpoint. 
Less screen clutter is present under 'First Entity Only'. Only available if Show Directions is checked in 
the View menu. 
 
Pocket Milling Tool Overlap 
When in the Pocket Window, the X-Y Step Size will automatically be calculated as this percent of the 
tool diameter. It can always be overridden. 
 
Try to correct bad DXF geometry 
This feature will try to correct 'overlapping' regions usually caused by Raster to Vector converters such 
as Corel Draw. 
 
Show Boundaries when Redrawing Toolpaths 
If View Toolpaths is selected in the View menu, you have the choice of viewing just the toolpath 
segments or the toolpath segments and the selected regions (If the selection hasn't changed then the 
selected regions represent the original boundaries and islands and contours). 
 
Post Processor 
Select the default Post Processor that is loaded when DesKAM is started. Machine code files will then 
be save according the definitions associated with this Post Processor. 
 
When Machining Tops of Islands at Multiple Depths 
Check this box if you want each island to have its contour traced when machining its top. By default, 
the tops of islands are machined with the current tools offset equal to half its diameter. By selecting 
this option, the entire top of each island will be machined. 
 

 
Text 
 
Font 
Select a default True Type Font. All text references in the DXF file will be converted to vectors while 
loading. 
 
Precision 
Each curve in a TrueType Font glyph will be converted to a series of line segments. The number of 
line segments per curve is set in the 'Percision' parameter. 
 

 
STL 
 
STL Depth 
The depth at which to set the top of the STL geometry on load. All geometry will be translated in the Z 
direction so that the Maximum Z value of the geometry is located at this depth. The Blank's Z2 value 
will be set to this depth. 
 
X and Y Step as percentage of cutter diameter 
The X and Y step size will be automatically set to a percentage of the cutter diameter when entering 
the cutter diamter in the machining parameters. 
       
Tip 
If your islands are always separated by any other region by at least 1/2 the current tools diameter, 
then you can safely trace the contour of each island. If an island is nearer to a boundary than 1/2 its 
diameter, then tracing the islands contour will gouge the boundary where it is less than 1/2 the 
diameter apart. 



 
Tip 
With Mark First Entity Only, you can easily determine the first segment of a region or toolpath. 

 

 

4.2 Post Processor Setup 

 

DeskNC utilizes a programmable Post Processor that can output many machine languages. Many of 

these can be read back in by the editor for viewing of the toolpaths. The post 'DeskNC' is a standard 

G-Code Post Processor that the program DeskNC can read and interpret. 

 

Name 

The name for this Post Processor. It should be a unique easily identifiable name. 

 

File Extension 

The file extension for the saved files. 

 

Comment Characters 

DesKAM inserts comments at the beginning of the file to denote time of creation, tool diameter and 

number, and the name of the Post Processor. Enter the character that begins a comment for this 

machine. 

 

Tokens 

Commands are broken down into 'Tokens'. A Token consists of an Address Label and a Value. The 

Token 'X2.5' begins with the Address of 'X' (in this case representing the X axis) and its value of 2.5. 

Tokens can begin with a space to make the output file more readable. All Tokens must be created 

before they can be used. To create a Token, select the Token you wish to create from the Tokens 

group and a variable. 

 

Available Tokens are : 

Xt for the X Position 

Yt for the Y Position 

Zt for the Z Position 

It for the Arc Center X Position 

Jt for the Arc Center Y Position 

Rt for the Radius 

Nt for the Line Number 

Ft for the Feedrate 

St for the Spindle Speed 

Tt for Tool Change 

Ct for tool clearance 

Misct for any miscellaneous commands 

 

Available variables are: 

None 

Sx for the Start Point X of a toolpath 

Sy for the Start Point Y of a toolpath 

Sz for the Start Point Z of a toolpath 

Ex for the End Point X of a toolpath 

Ey for the End Point Y of a toolpath 

Ez for the End Point Z of a toolpath 

Sa for the Start Angle of an Arc 

Ea for the End Angle of an Arc 

Rad for the Radius of an Arc 

Cx for the Center X of an Arc 

Cy for the Center Y of an Arc 

Ix for the Incremental Center X of an Arc 



Jx for the Incremental Center Y of an Arc 

Cv for the Clearance Value 

Nv for the Line Number Value 

St for the Spindle Speed 

Tn for the Tool Number 

 

Enter the number of decimal places for this Token and whether it needs a '+' to denote positive 

numbers and press the Create button. An example of the newly created Token will be displayed at the 

bottom. 

 

Movement Script 

This is the script that defines how a command line will be formatted in the output file. It consists of 

adding a Command along with the previously defined Tokens. The typical G-Code line N100 G01 X2.5 

Y3.6 Z 4.7 consists of a 'Line Number Token', Command 'G01', 'X Position Token', 'Y Position Token', 

and 'Z Position Token'. Movement Scripts can be either a single command line or a block of 

continuous commands as set by the 'Single Move' or 'Continuous' selection. 

A Non-Model Token (default) will be written to the output file even it is identical to previous value. 

A Modal Token will only be written to the output file if it is different from its previous value. 

 

Movement Script Example : 

- Select 'Linear'. 

- Select 'Single Move'. 

- Enter 'G01' in the Command box. 

- Select the 'Nt' Token and press the Add button ( N--- ) 

- Press the Add Command button ( G--- ) 

- Select the 'Xt' Token and press the Add button ( X--- ) 

- Select the 'Yt' Token and press the Add button ( Y--- ) 

- Select the 'Zt' Token and press the Add button  ( Z--- ) 

- Select 'Ft' and press the Add Modal button ( <F---> ) 

As each button is pressed, an example of the formatted line is displayed at the bottom. The feedrate 

Token (Ft) is displayed in brackets to show that it will only be written if it differs from a previous value 

(modal command). 

 

Result in POST.CFG file : 

Scripts0=F* G01*6*F*-1*F*0*F*1*F*2*F*7*T 

 * : text separator 

 F* : start of script  

 6*F : non modal command (line number) 

 -1*F : put previous command (6*F here) at the beginning of the gcode line 

 0*F, 1*F, 2*F : non-modal command (X, Y, Z coordinates) 

 7*T : modal command with token7 (feed rate) 

 

 

Header / Footer 

Here you can add any miscellaneous start up or end commands that will be written to the output file. 

you can also add your own comments. 

 

Save 

Saves the Post Processor definition to a file so it can be used when saving toolpaths. 

 

Delete 

Deletes the Post Processor selected under 'Name'. You will be prompted for confirm. 

 

Edit 

Loads a previously created Post Processor for editing. 

 



5 View 

 
5.1 Zoom Previous 
 
Displays the previously displayed view before a zoom command was executed. 
 

 
5.2 Zoom In 
 
Zooms in the amount set in the Zoom In/Out Percent Option. 
 

 
5.3 Zoom Out 
 
Zooms out the amount set in the Zoom In/Out Percent Option. 
 

 
5.4 Zoom Window 
 
Hold the left mouse button down and drag a box around what you wish to magnify. 
 

 
5.5 Zoom All 
 
Fits the entire DXF File in the main window. 
 

 
5.6 Zoom Selected 
 
Fits only those regions that are selected to the main window. 
 

5.7 Show Directions 
 

 If this item is checked, a small arrow will be displayed at the midpoint of an entity. If the Mark First 
Entity Only option is selected, only the first entity in a region will be marked. Likewise if the Mark All 
Entities option is selected, all entities will have an arrow displayed at their midpoint. 
 
Tip 
With Mark First Entity Only, the first segment of a toolpath is easily distinguished. 

 
5.8 3D 
 
Toggles 3D and 2D viewing of geometry and toolpaths. When in 3D mode, geometry can be 
dynamically zoomed and rotated in 3D space. 
 
Redraw 
Redraws the screen. 

 

5.9 View All 
 
Selecting View All will display all regions in the loaded DXF File. The second panel of the status bar 
will display All and the total number of segments. 



 
 
5.10 View Selected 
 

Selecting View Selected will display only those regions that are currently selected. The second panel 
of the status bar will display Selected and the total number of selected segments. 
 

 
5.11 View Toolpaths 
Selecting View Toolpaths will display only the toolpath segments that were created from a 
previous Toolpath command. The second panel of the status bar will display Toolpath and the total 
number of toolpath segments. 
 
Tip 
Use the Show Directions option, and the Information command to get a good visual representation of 
the loaded file. 

 

5.12 Show Tool Bar 
 
This menu item will show the toolbar at the top of the main DesKAM window when it is checked. It will 
likewise remove the toolbar when unselected. Removing the Tool Bar increases the viewing area. 

 

 

6 Select 

 

6.1 Select All  

This command will automatically select all islands within all boundaries, all boundaries within all 
islands (Nested boundaries and nested islands), and all open regions. Use this command when you 
want to generate toolpaths for the entire DXF File or the majority of it. 
 
To Cancel select operation 
Press Esc. 

6.2 Select All Open 

This command allows you to select only open regions. Open regions can be processed by 
the Contour function only. 

 

6.3 Select All Closed 

This command will select only those regions that are closed. It will automatically determine islands 
within boundaries and boundaries within islands (Nested boundaries and islands). It is most useful 
when utilizing the Pocket command. 
 
To Cancel select operation 
Press Esc. 
 



 

6.4 Select All as Islands 

Selects the outermost region as a boundary and and all other regions as islands to that 
boundary. 
 
This feature is used mainly for the routing of PC boards. When creating PC board geometry, create a 
box surrounding all traces and pads. When 'Select All as Islands' is invoked, all islands and pads will 
be selected for use in the PC Board Routing function. 

   

6.5 Select Window 

This command will select all boundaries, islands, contours, nested boundaries, and nested islands 
within the selection box. To use this command, hold the left mouse button down and drag a box 
around the area you are interested in. 

 

6.6 Select Region 

Use this command by clicking the left mouse button on the outermost closed region that you are 
interested in. It becomes a boundary. All islands to this boundary, contours, nested boundaries, and 
nested islands within this boundary will automatically be detected and selected. 

 

6.7 Select Single 

This command will select a single region. Click the left mouse button on the region you want to select. 
DesKAM will determine whether this region is a contour, boundary, or an island to an existing 
boundary. 

 

6.8 Select Empty Circles 

This command will select all circles that have no other regions inside of them. It is used mainly for 
the Drill function to select the drill points. 

 

6.9 Single Boundary 

This command will select a closed region and force it to become a boundary. Click the left mouse 

button on the region you want to select as a boundary. You may never need this command. Use this 
command if one of DesKAM's automatic selection tools fails to select a region as a boundary and 
you know it should be! 

 

6.10 Single Island 

Use this command to force a region to become an island. To use this command you must first declare 
the boundary that this region will be an island to. Left click on the boundary (It does not have to 
actually be selected). Now left click on the region you want to force to become an island to this 
boundary. You may never use this command. Use it if one of DesKAM's automatic selection tools fail. 
 
Tip 
Use the Information command afterwards to verify that the island is actually an island to the boundary 
you declared. 



    

6.11 Deselect All 

Deselect All 

This command will Deselect everything. All boundaries, islands, and selected contours will revert back 
to unselected regions. 
 
Tip 
- Use the Information command to see which islands belong to which boundaries. 
- It is easier to select more regions than desired and then Deselect what you don't want than to select 
what you want one at a time. 
 

 

6.12 Deselect All Open 

This command will deselect all selected contours. 

 

6.13 Deselect All Closed 

This command will deselect all selected closed boundaries and islands. 

 

6.14 Deselect Window 

This command will deselect everything within the deselection box. To use this command, hold the left 
mouse button down and drag a box around the area you want to deselect. 

 

6.15 Deselect Region 

Use this command by clicking the left mouse button on the outermost selected closed region that you 
are interested in. All islands to this boundary, contours, nested boundaries, and nested islands will be 
deselected. 
 
Tip 
If your geometry has only one boundary (NOT counting nested boundaries) then this command will be 
a little faster than the Select All command with the same results. 

 

6.16 Deselect Single 

This command will deselect a single boundary, island, or contour. Click the left mouse button on the 
region you want to deselect. 
 
Tip 
Select an outer boundary first, then select its islands when using this function. 

 

6.17 Deselect Empty Circles 

This command will Deselect all circles that have no other regions inside of them. 

 

 



7 Toolpaths 

 

7.1 Tooling parameters 

These definitions and guidelines are common to all toolpath functions. For help on an 
individual toolpath function see the help for Pocket, Contour, Drill, or Route. 
 
Tool Number and Name 
Select a tool from the drop down tool selection box or enter a Tool number directly. This number will 
be reflected in the Posted Machine Code. Enter a name in the Tool Name box. This name will be 
commented into the Posted Machine Code file when Toolpaths are saved. 
 
Rapid height 
The height at which rapid traverses occurs. Enter a value the amount above the work piece (Z=0) to 
allow clearance for the tool when it is travelling to its next position. This value is always positive. 
 
Spindle RPM 
The speed (In RPM) to set the spindle to. Use a value that reflects your cutters diameter and the 
material you are machining. 
 
Plungerate 
The rate to drop the tool or drill. 
 
Line Number starting value 
The number corresponding to the first line in the Machine Code File that will be created. Default is 
100. 
 
Line Number increment 
The amount to increment the line numbers by. Default is 2. Line numbering can be added and 
removed in the editor. 
 
Coolant 
Select either On or Off. 
 
Configuration 
Select a user defined configuration from the entry box and press Load. All saved parameters will be 
loaded. To save a new configuration, enter all tooling parameters first. Then enter a unique identifying 
name in the entry box and press save. If the configuration already exists, you will be asked to 
overwrite it. To delete a configuration, select it from the entry box and press delete. 
 
 

7.2 Multiple Depths (All Toolpath Functions) 
 
Selecting Multiple Depths 
Any Region can be set at any depth before executing any of the Toolpath functions. It is 
recommended that Show Information is active to display the current depth of each region. By selecting 
'Change Depths' from the Edit menu, a small window is displayed. Islands are automatically updated 
to reflect the new depths. If an Island's depth becomes deeper that its parent Boundary then it 
becomes a nested Boundary and changes color to reflect this. therefore, it is recommended that the 
depths of Boundaries are changed before the depths of Islands. All depths need not be set under this 
command. Selected Boundaries that have a depth of Zero will take the depth set in one of the toolpath 
functions. To set a new depth, enter a new depth and select which Regions to apply it to. The new 
depth can be applied to all of the Selected Boundaries, all of the Selected Islands, or to an individual 
Region. Pressing the Apply button sets the depth(s) and updates the display to reflect the changes. 
 
 
Action of the Multiple Depth function during pocketing 
While machining islands at different depths, DesKAM will first remove material around an island until it 
reaches a depth greater than the depth of the island. DesKAM will then remove material from the top 
of the island according to that islands depth. 



 

7.3 Wall Profiles (Pocket and Contour Functions) 
 
Selecting Wall Profiles 
When this command is invoked, a DXF file named Profiles.dxf will be loaded. Depths should be set 
prior to adding wall profiles. It is recommended that Show Info is active when using this function. By 
default, all regions have no (0) profile which is the same as a straight vertical wall. To select a new 
profile, enter the region number in the region entry box. Select a new profile in the profile entry box 
and enter its Delta value. The profile will be displayed in the profile viewing box. Press Apply to attach 
this profile and Delta value to this Region. 
 
Delta 
Delta is the offset of the profile at the bottom of the Region. By changing the offset at the bottom of the 
profile, a single profile can represent an infinite number of profiles. Therefore, a single straight line can 
represent a tapered wall at any angle and a quarter circle can represent any quarter elliptical profile. 
By default, the delta value for each region is equal to its height. At any time, entering a - (negative 
value) will cause the default delta value to be set. Entering a value greater than the default will 
increase the bottom offset of the profile. 
 
Creating New Profiles 
In your CAD program, load the file profiles.dxf. Find an empty area and draw a new profile. Keep the 
aspect ratio consistent with what you intend to use this profile for. In other words, draw the profile 
exactly as you would want to use it. The size of the profile is unimportant. The profile will be scaled to 
the depth of the region it is attached to. Save the new file as Profiles.dxf. 

 

 

7.4 Entry/Exits (Pocket and Contour functions) 

Entries and exits are available for the contour function and for the finishing pass of the pocket function. 
By default, entry/exits will turn away from the contour. The side of which the entry/exit is located can 
be reversed by entering a negative value for the length or radius. Entering a negative value for a 
tangent entry/exit has no effect because a tangent lead has no side. 
 
Definitions and guidelines 
 
Arc 
Adds a quarter circle of the specified radius tangent to the beginning or end of a contour. Enter the 
radius. 
 
Perpendicular 
Adds a perpendicular lead of the specified length to the beginning or end of a contour. Enter the 
radius. 
 
Tangent 
Adds a tangent lead of the specified length to the beginning or end of a contour. Enter the length. 

 

 

7.5 Pocket 

 For Definitions and Guidelines common to all Toolpath functions go to Common tooling 
parameters. 
 
Definitions and Guidelines 
 
X-Y Step Size 
The amount to offset the next loop in the spiral pocket. It is automatically calculated if the diameter of 
the tool is known and the Tool Overlap in the options is >0. X-Y Step Size = Tool Overlap x Diameter. 
Enter a new value to override. 



 
Pocket Depth 
The finished depth of the pocket. Enter a positive value. If depths were added using the Change 
Depths function, then only Boundaries with a depth of Zero will be set to this depth. All others keep 
their current depth. 
 
Z Step Size 
The depth to cut each roughing pass. If the depth of a Boundary is greater than this value, multiple 
passes will be created. 
 
Stock to leave 
The amount of material left over for the finishing pass. 
 
Feedrate 
The rate to perform the pocketing operation. 
 
Use Finishing Pass check box 
When checked the finishing parameters will be enabled. A finishing pass consists of removing material 
left by the roughing pass('s). The Stock To Leave field in the roughing pass section does not have to 
be filled in. You should always use a finishing pass when your geometry has islands as the roughing 
pass will not completely trace the entire outline of the islands. 
 
Finish Island / Boundaries / Both 
Islands only will only finish the islands during pocketing. Islands and boundaries will finish both islands 
and boundaries. Both + Bottom will also finish the bottoms and tops of islands and boundaries. 

 

 

7.6 Contour 

 For Definitions and Guidelines common to all Toolpath functions go to Common tooling 
parameters. 
 
Definitions and Guidelines 
 
Contouring Depth 
The finished depth of the contour. Enter a positive value. If Depths were added using the Add Depths 
function then enter a value of zero here. 
 
Z Step Size 
The depth to cut each pass. Entering a value less than the depth of a region will create multiple 
passes in Z Step increments until the final depth is achieved. 
 
Feedrate 
The rate to perform the contouring operation. 
 
Cutter Compensation (None) 
Setting cutter compensation to off will produce toolpath segments that trace the selected regions 
exactly. 
 
Cutter Compensation (Left, Right) 
Setting cutter compensation to Left will produce toolpath segments that are offset by the tool diameter 
on the left side of Regions. Left or Right are calculated from the direction of the start of the first 
segment to the end of the first segment. DesKAM will offset the toolpaths by the diameter of the tool 
on this side of the contour. 
 
Cutter compensation (Cutout) 
Setting cutter compensation to cutout will offset all islands by the tool diameter on the inside first and 
then offset all boundaries on the outside. This will effectively cutout a selected region. It has no effect 
on open contours. 



 

7.7 Drill 

 For Definitions and Guidelines common to all Toolpath functions go to Common tooling 
parameters. 

 

 

7.8 PC Board 

For Definitions and Guidelines common to all Toolpath functions go to Common tooling 
parameters. 
 
The PC Board Routing function differs from the Contour function in the way that Islands are avoided. 
The PC Board function avoids all Islands as a selection where as the Contour function will Contour 
each region separately. The PC Board will only route closed Islands. It is therefore recommended to 
encase all traces and pads with a closed box and use the Select All as Islands command. 
 
Definitions and Guidelines 
 
Routing Depth 
The depth to route the Islands. Enter a positive value. Only Islands are routed. 
 
Feedrate 
The rate to perform the routing operation. 

 

7.9 Prototype 

This toolpath function is used to create toolpaths from 3D STL files. 
 
For Definitions and Guidelines common to all Toolpath functions go to Common tooling 
parameters. 
 
Definitions and Guidelines 
 
Blank Size 
The Blank is the dimensions of the solid material from which the part is to be machined from. By 
default, it is set to the extents of the STL geometry. Decreasing the default Blank size will machine 
only a portion of the STL geometry. X1, Y1, and Z1 represent the bottom left corner while X2, Y2, and 
Z2 represent the top right corner of the Blank. 
 
Male/Female 
Selecting Male will cut around the loaded geometry to the extents of the Blank size. Selecting Female 
will only cut the geometry and is equevelant to 'inverted' male machining. 
 
Direction 
Toolpaths can be created along the X or Y axis and follow a Zig Zag pattern. For best surface finish, 
the Finish pass should be opposite the Roughing pass. 
 
Tool type 
Three different tool types can selected for machining - End, Ball, or Vee shaped tools. When a Vee 
tool is specified, the included angle is required. An angle of 180 represents an End mill. 
 
X, Y, and Z Step 
The X Step size is the distance along the X axis for each segment of the toolpath. The Y Step size is 
the distance along the Y axis for each segment of the toolpath. The X and Y step sizes are 
automatically entered for a given tool diameter as specified under Options- X and Y Step size as a 
percentage of cutter diameter. The Z Step size is the depth for each pass. 



8 Registering 

 
8.1 Days Remaining 
 
This menu item will display the Days remaining under the trial period. DesKAM will run for 30 days 
before the Toolpath functions will cease to work. After 30 days you must Purchase 
and Register DesKAM to continue using the Toolpath functions. The demo is limited to 1,000 lines of 
machine code that can be saved at a time. 

 

8.2 Register 
 
Simply enter your user name and registration code in the appropriate fields. You may need to restart 
DesKAM for the registration to take effect. 


